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Description 

You've seen lots of preliminary design with InfraWorks 360. This session will focus on 
presentation techniques to make your site plan look its best. We'll explore Civil 3D, Revit, and 
other data sources and how to make the most of each, along with some great options for 
sharing your brilliance.  
 

James Wedding, P.E. 

A customer, gunslinger, consultant, and employee, James has spent most of his career getting 
the most out of Autodesk, Inc., solutions. James is now part of the Strategy and Marketing 
group, bringing his pragmatic expertise in civil engineering to bear on Autodesk Transportation, 
Land Development, and Sustainability Solutions.  
 

 

 
 

Learning Objectives 

 Learn how to display Civil 3D data in InfraWorks 360 

 Learn tricks for making linework pop in InfraWorks 360 

 Learn how to turn a landscape plan into a 3D planting scene 

 Use InfraWorks 360 to prepare an evolving timeline of your project 
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Just Don’t’ Bore Me 

We talk about InfraWorks 360 as a conceptual design tool, able to knock out multiple 
alternatives in the space of a few hours with data that’s easy to access and tools that are easy 
to learn. But what about the other end of the job? When it’s time to go talk with your client, 
owner, reviewer, review board, or neighborhood association? How can you take advantage of 
the rich design data you’ve already generated to make an exhibit that tells the story of your 
design in a way that makes it understandable to everyone?  
1. Deliver Context 
2. Show Before and After Views of the Job 
3. Add Detail to Add Richness 
4. Use Animations and Videos to Bring Excitement 
 

Delivering Context 

Getting the existing conditions right is one of the most important aspects of showing off your 
project. Context is king, and to truly deliver context, InfraWorks 360 has some tools you can 
use. Let’s get started with the basics: building a model from InfraWorks 360’s Model Builder 
tools, improving the aerial photo that’s delivered by default, and adding 
in some basic GIS information.  
 

Upping the Aerial Resolution 
Now, do this first part when you’re about to go home for the day, or 
when you’re headed to a meeting, it can take a little while to process.  
1. Launch Model Builder from within InfraWorks 360 and select your 

site. Remember, you can run up to 200 km2, so give your project 
site some room to breathe! If you’re dealing with a project near 
physical landmarks such as an iconic structure or terrain conditions 
that act as orientation, try to include them. And don’t be afraid to 
use a polygon, rectangles are boring! 

2. Once the model is complete and downloaded, open it up, and 
before you make any changes at all, open the Data Sources panel. 

3. Navigate to the Ground Imagery branch and double-click on 
Imagery to open the Configuration dialog. 

4. Switch to the Raster tab, and near the bottom, change the Tile 
Level to 19.  

5. Click Close & Refresh, and go grab lunch. 
 
This will pull in an approximately one foot-pixel image, up from a four foot-pixel image. And 
remember, that a 4x4 improvement, so you’re pulling down 16 times the amount of data. 
 

Adding in GIS Data and Using Rules 
Once you have a good aerial loaded up, let’s take a look at the existing conditions. In this case, 
we want to show a Zoning exhibit, and make it easy to reproduce for future models in the same 
area. 
1. Download the zoning GIS data from the local authority. If they don’t have it on their 

website, call them. They have it. 
2. Create a GIS BASE.dwg set the coordinate system, and drop in the SHP file.  
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3. Open the data table using 
the Map Workspace if 
necessary and examine the 
options for data.  

4. Note the data columns of 
interest. In this case, Base or Zoning, take your pick. 

5. In InfraWorks 360 create a new proposal and 
drop in the SHP file. Select appropriate values 
for the Name and Description mapping. For 
now, don’t select a style, we’ll use Rules to do 
that. 

6. Select on screen to verify that you got 
coverages and that the name were applied 
appropriately. 

7. Open the Style Rules panel and switch to the 
Coverage Areas tab. 

8. Create a new Rule Style, but use the expression NAME LIKE ‘C-%’ to select wildcard 

matching districts. You can use the LIKE expression for lots of things! 
9. Select a Style for that zoning class, click OK 

to close and then Run Rules on the bottom 
right to see the effect. 

10. Repeat this process for each category testing 
as you go. 

11. Once you have a good set of rules, save 
them! You can Export ALL or Export just the 
rules you want to save off, but save them for 
future projects!  

With some basic understanding of the legal 
conditions in place, we can begin to look at the 
existing physical conditions 
 

Surveyed Surfaces  
To really show off a project, you’ll want to show off all aspects of the Civil 3D model. For most 
projects this means working with points, parcels, surfaces, alignments, corridors and pipe 
networks. Some of this usage is pretty straight forward, but each still has some tricks we’ll want 
to look at. Let’s start at the top, the existing ground condition survey.  
 
A note about best practices before we start. Isolating data is a good idea. It makes it easier to 
update, it makes it easier to follow the chain of possession if something changes, and it makes it 
easier for the next person to update your model if you are hit by a bus. Creating a few AIW only 
drawings with just data shortcuts makes life easier. In the case of many firms, the EG topo file is 
isolated, so just use that. 
 

1. Drag and drop the topo file into InfraWorks 360. You’ll 
be presented with a dialog asking the type of objects 
to import. Select AutoCAD Civil 3D DWG. This will 
essentially isolate the Civil 3D objects in that drawing, 
ignoring the linework. 

2. Click OK and the configuration dialog will appear. 



 

 

Page 4 

3. Check through the tabs to confirm the location (coordinates) was picked up 
correctly, and then on the Converter tab, uncheck the 
Convert to Grid option. This will give you the most 
accurate representation of the survey data.  

4. Click Close and Refresh to close the dialog and update the 
model.  

5. Mouse around the site, especially looking for boundary 
interfaces where the Model Builder data and the Survey 
data don’t line up very well. You can fix these areas in a 
number of ways:  

a. Merge the AIW Existing Ground surface with the Survey 
Surface in Civil 3D and then perform a smoothing 
operation on the areas that don’t quite line up. 

b. Draw a coverage in InfraWorks 360 covering the area in 
question. Modify one vertical grip some small amount and 
watch the surface smooth out. Change the style to null and 
your surface smoothing will be gone.  

 

Tree Surveys 
One of the most common predesign pieces of the puzzle is a tree survey. While this isn’t 
as easy as it could be, once you’ve done it a few times, you’ll find you can run through 
the process in just a few minutes. 
1. Open up your Civil 3D survey file and export the 

Tree point group out to a text file. PNEZD is the 
easiest way to get handle it.  

2. Create a new drawing and set the coordinate 
system 

3. Use the MAPIMPORT command and select the 
text file just created.  

4. Use the MAPDWGTOSDF command to export 
the tree blocks just created as an SDF file. This 
creates a GIS file of the trees that InfraWorks 
360 can handle more easily. Use the Select All 
option since we’re dealing with just tree points in 
this drawing. 

5. Drag the new SDF file on top of the InfraWorks 
model to import the trees and the Configuration 
dialog will appear. 

6. Set Type to Trees, and the Draping option to 
Drape to just push the trees to the surface 
elevation. 

7. Switch to the Script tab, click the Edit button, and paste in this code snippet: 
function Process(SOURCE, TREES) { 

TREES.DESCRIPTION = SOURCE["DESC"]; 

TREES.EXTERNAL_ID = SOURCE["FeatId"]; 

var descString = SOURCE["DESC"].split(/\s+/); 

TREES.NAME = descString[2]; 

if (descString.length >= 2) { 

if (descString[2] == "OAK") 



 

 

Page 5 

TREES.RULE_STYLE = "3D Model/Vegetation/T19-

V03 Dark Red"; 

else 

TREES.RULE_STYLE = "3D Model/Vegetation/T19-

V03 Green"; 

var scale = descString[1] / 12; 

TREES.MODEL_SCALE_X = scale; 

TREES.MODEL_SCALE_Y = scale; 

TREES.MODEL_SCALE_Z = scale; 

} else 

TREES.RULE_STYLE = "3D Model/Vegetation/T19-V02 

Yellow"; 

return true; 

} 

 

NOTE THAT YOU WILL NEED TO UNDERSTAND AND EDIT THIS SCRIPT TO MATCH YOUR FIRM’S TREE CODING STYLE 

AND THE STYLES YOU WANT TO HAVE SHOW UP IN INFRAWORKS 360. THE IF/ELSE LOOP NEEDS TO BE EXPANDED 

TO GET A FULL RANGE OF TREES COVERED, BUT THIS SHOULD GET YOU TO A GOOD STARTING POINT! YOU CAN 

ALSO DO MUCH OF THIS WITH RULES AS WE’LL SEE IN THE LANDSCAPE SECTION, BUT IT’S HARDER TO CONTROL 

THE SCALE BASED ON TYPICAL TREE SURVEY CODING RULES. 

 
8. Click Close & Refresh to display the tree survey. Select an individual tree and open 

the Properties dialog to verify that the scale factor was applied as expected. 
 
If more trees are added, you can always repeat the process to update the SDF file and reload. 
Isolating data sources makes updates easy, and you can continue to use it throughout the site 
design process! 
 

Getting Legal With It 
One last bit of data to add before we get into looking at design conditions. Let’s bring in the 
parcels that make up our site.  

1. Open up the plat file and make sure you are actually looking at has parcels in it. If you’re 
working from linework only, you can use those well, but it is easy to wind up with open 
parcels that won’t close in InfraWorks 360 either. 

2. Switch to the Output tab and use the command Export Civil Objects to SDF. This will spit 
out all of the Civil 3D objects that can be GIS-ified (yes, that’s a made up word.) into an 
SDF file. 

3. Drag the new SDF file into InfraWorks 360 to bring up the Configuration dialog. Click OK 
without any configuration. 

4. Now look at the Data Sources panel and near the top you’ll see <No Feature Type>. In 
many cases, you’ll see two, or maybe three sources listed there, ALL from the SDF file 
you created in your plat. It all depends on how clean your survey folks are. In my case, I 
have Points and Parcels.  
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5. Double click the Parcels option to bring 
up the Configuration dialog. Set the type 
to Parcel (a new option in 2017.2!) and 
select a style that makes sense. Note 
that Parcels do NOT have fills, they have 
strokes.  

6. Click Close & Refresh to update and 
display the Parcel in your model.  

7. Select one of the lines, and on the Asset 
Card, look near the bottom, and you can 
turn ON contours!  

 
In the image, you’ll see I also configured the Points that were in the survey as POB, that’s the 
balloons you see there in the left and right corners. OK, existing conditions done, let’s take a 
look at the rest of the design process. 
 

Presenting the Design  

After the initial design, you’ll need to start showing off your vision for the proposed site. That can 
occur during design with the surface, bringing in a full blown Revit model, and then you can 
wrap up the final site plan using linework to make the full site plan pop. 
 

QA & QC During Design 
 
The typical review process during design goes something like this: 
“Hey, print me out a set of the latest plans.” 
“OK, give me about 30 minutes.” 
“Just leave them on my desk, I’ll check them when I get back from the afternoon precon.” 
“OK.”  
 
And then we walk back to our desks muttering that by the time the review happens, the prints 
will be out of date because we’ve been working on the design the whole time they were sitting 
on said desk. It doesn’t have to be that way! Let’s see how we can bring in the design data. 
 
1. Create an isolated drawing to just carry the Finished Ground surface. Many 

grading drawings and plans consist of a number of temporary or island surfaces, 
making them a confusing mess when brought in to InfraWorks 360. Isolation 
makes this easier. 

2. Create a new proposal for QA work. 
3. Drag and drop the FG drawing in to the InfraWorks 360 model, and turn off the 

Convert to Grid option as before. 
4. Bring the Plat SDF file in again, but this time, 

we’ll configure it as a Coverage in order to color 
over the existing aerial. Select a color or terrain 
material. At this point, we’re using the display to 
look for surface busts. 

5. Go ahead and delete the trees from this proposal, 
they’ll likely be removed as part of the 
construction.  
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Now you can easily see anomalies in the site grading, and give that feedback to the designer 
that is handling the grading plans. And as the site plans change, simply reloading the reference 
drawing source data will update the model. Think of this as a model XREF that you don’t have 
to be in AutoCAD to use. 
 

Ground Coverages 
Now we need to work with painting the scene appropriately. We have a Site Plan and a 
Landscape plan that both have various types of groundcover, whether that is asphalt and 
concrete, or mulch and grass. Both of them will come in the same way, as coverages. To best 
portray your site, you need to work from the bottom up, layering coverage areas one on top of 
another. We already have the surface covered, but now 
we can add to it. 

1. Create a new Proposal and change the surface to 
a concrete/asphalt style. Everything will be built 
on top, so we have to start with something. 

2. Switch back to Civil 3D and your site plan 
drawing.  

3. Starting with Parking Striping. Isolate the layer 
with the striping and export to SDF like you have 
before.  

4. Bring the new SDF in, setting the type to 
Coverage.  

5. Change to the Table tab, and scroll down to the 
Buffer area. Enter a value of 2, and change the 
unit to inches. Click close and refresh to complete 
the parking striping. 

6. Repeat a similar process with any other ground coloring, such as a fire lane. Remember 
that if your polylines are closed, and you don’t want them filled, you’ll uncheck the 
Convert Closed Polylines to Polygons option on the Source tab.  

7. For fill areas on your site plan, you’ll typically look for hatch areas on your construction 
documents. If you’re lucky, you’ll find lots of closed polylines defining hatch areas. If not, 
you can use the Hatch Recreate Boundary tool to create a new, closed polyline. Export 
these new polylines as SDF and assign Coverage and Style as needed. One last trick—
you can use 6” tall buildings to represent parking islands, even if the site has not been 
modeled to that level of detail. Remember, this is about communication! 

 
You can keep going with this for as many elements as you need. Riprap? Concrete Paving? It’s 
up to you how far to take it. You can also make individual changes to elements if you need to 
once they’re in, just swap out the style! One of the things you’ll notice in this process is how bad 
come CAD can be. Don’t be a jerk about it, use it as an opportunity to remind folks of why 
closed boundaries, layers, and coordinates matter! 
 

Landscape Planting Plans 
This is probably the most tedious part of the process, because the first time you do it, or for 
every LA you work with, you have to set up and create all the rules. But once you do, it’s really 
amazing to watch an entire site plan populate with shrubs and trees right before your eyes. The 
hardest part of this process is that many LAs use blocks instead of points, and getting a block 
map to a GIS file can be a bit tricky. 
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1. Open up the Planting plan, and take a look at the blocks involved. What you’re hoping 
for is a collection of blocks where each name represents the plant species. Make sure 
the drawing is on the right coordinate system as well, or things won’t work out. 

2. Begin the EATTEXT command. This is actually the Data Extraction Wizard now, but I 
like command line tools, so…. 

3. Save your Extraction somewhere. You’ll probably 
have to do this multiple times, so place it in your 
project. 

4. Click Next to accept the Current Drawing as the data 
source.  

5. Turn off Display All Object Types and select Display 
Blocks Only. Toggle Display Objects Currently In-
Use Only as well to hide unused blocks. If the list still 
contains any blocks that do not represent plantings, 
uncheck them. Click Next. 

6. Right-click to Uncheck All, then select the Position X, 
Position Y, and Position Z options. Click Next. 

7. Make sure Show Count Column and Show Name Column are checked, and arrange the 
columns in a Count, Y, X, Z, Name order—this will line up with a PNEZD point format 
later. Click Next. 

8. Check the Output Data to An External File option and click the Ellipsis button to navigate 
to a saved location. I like CSV but it’s up to you. 

9. You will likely need to edit the CSV to get it to import, as there is a header row, and 
some Unicode characters that the Point Wizard does not like. Open the file in your editor 
of choice, remove the header, and save the file. For some, copying and pasting the 
remaining text into a new file may be necessary to get rid of the Unicode. 

10. Return to Civil 3D, and import the CSV using the Civil 3D Point Import Options. It will 
complain about duplicate point numbers, but 
that’s OK, just let Civil3D assign them. 

11. Run the Export Civil Objects to SDF command 
to end up with a SDF full of tree points. 
WHEW! 

12. Drag this new SDF file in to InfraWorks 360 
close the Configuration dialog, just in case you 
picked up any extra objects.  

13. Double click on the Points data, set the Type 
to tree, set the NAME value to Description, 
and pick a temporary style. I like picking a 
NON-Tree style so I can see what trees I still 
need to classify. Close & Refresh and you’ll see a planting plan brought to life, albeit as 
markers, not plants.  

14. Now open the Rules panel. For each species of plant, we need a rule, so for each 
unique NAME, we need a rule. 

15. Switch to the Tree tab and create a new rule. Name it after the species to be planted. 
Set the expression to NAME = 'RED YUCCA', but swap out the RED YUCCA bit for the 
name of the blocks you just brought in.  

16. Set the Style equal to a 3D Object style that reflects and approximate representation of 
your plant in question. I’m a big fan of the 3D Warehouse for finding plant models! 

17. Run this rule, and you’ll see some of the markers disappear and tree or shrubs appear in 
their place.  



 

 

Page 9 

18. Repeat this process for each block/marker in your model, until they’re all gone and you 
have a complete planting plan. 
 

Once you have created these rules, do not forget to export them out! And take the styles you 
might have made along for the ride! 
 

Bulking Up the Buildings 
It’s not really so much bulking as massing. Before you have a Revit model ready to insert, many 
times you’ll have a building footprint, and that can be used as a massing placeholder during 
presentations.  

1. Open up the site plan, select the footprints and export them to SDF using the same 
MAPDGWTOSDF command. 

2. Drag the SDF into your InfraWorks 360 model. 
3. Set the type to Building. Switch to the Source tab. 
4. Set the Draping Option to Drape. 
5. Click Close & Refresh 
6. Adjust the height as needed using the gizmos. 

 
If you miss a building, you can always just append the SDF file, but remember that any changes 
will disappear when you click Close & Refresh again! 
 

Revit in the Real World 
When your architectural partner is ready, you’ll likely be handed a Revit model (RVT file) for 
insertion into your model. Just like every other data source, this can be updated throughout the 
modeling process, so if they’ll give you even a good placeholder, you can use it in your model, 
and then update throughout the design process…maybe using BIM 360? Or Collaboration for 
Revit? It’s up to you!  
 
There are a number of details that come in to play when importing a Revit model in to 
InfraWorks 360. To really understand the full process, visit Autodesk InfraWorks 360 Help and 
search for “To import Autodesk Revit files.” There are lots of details and methodologies there for 
very precise placement, cleaning up of Revit models, and how cloud file conversion works. 
 
The easiest way to place a Revit model is to place it manually, and that’s the method I’ll use for 
expediency. The main thing I want to note is that you NEED a view in Revit to control how your 
model will appear in InfraWorks 360.  

 If you have Navisworks on your machine, you’ll want to 
specify a view called NAVIS-  

 If you are using the cloud service to translate, you’ll want a 
view called ToAIM or ToAIW 

If you’re working with an Architect as a partner, as them to do this 
for you so you don’t lose your changes when you get a new RVT 
file. 
 
Once you have a view created in Navisworks (and you might want to 
control what’s shown. Remember, we’re showing the site, so you 
probably don’t need to calculate the display of the cable-tray 
hangars. In Revit, select your view, and then select the View tab, 
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and then click the Visibility/Graphics tool to 
display a list of toggles where you can toggle on 
and off full categories of model information. Click 
Apply as you work your way through to make 
sure you’re not losing any valuable bits of the 
model. 
 
If you have Navisworks available, you can always 
import the Revit model there to check out your 
results before you try and import it in to 
InfraWorks 360, but it’s pretty quick to bring it in 
to InfraWorks 360, so let’s just jump in there. 
 
1. Create a new proposal. 
2. Drag the RVT file into InfraWorks 360. 
3. On the Configuration dialog, Geo Location tab, set the insertion to Center 2D. 
4. Switch to the 3D Model tab, and make sure you’re getting what you expect. 
5. Switch to the Geo Location tab again, and click Interactive Placing to place the building 

in the model. 
6. Double click near the site to set the position. 
7. Click Close and Refresh to complete the insertion. 
8. Select the building and use the gizmo to adjust. Remember, if your building has 

subgrade beams, etc., you may need to use the Z axis transform to push it below grade! 
 
With the building complete, you’ve completed your site plan, and now you can show off. 
 

Putting Your Site on Display 
Here are some tips for putting your model out there, and making sure people get the best views 
they can of your work. 

 Always use a Watermark! Whether you do it in the model, or in post, always put your 
brand on your work. It matters at every step of the way. You did the work, make sure 
your client knows it, and make sure the public knows it.  

 Use Snapshots and Bookmarks! Take a snapshot of the project from the same 
bookmark for each proposal. Then use full image slides with a blur transition, and watch 
your project fade from existing to construction to complete to five years from now. 

 Use Camera Paths! Camera paths are independent of proposals. Get a camera path 
that you like of your project, or just do a simple orbit around the site. Record that video 
for each proposal, and use editing software to blend them together. Since the videos are 
the same length, you’ll see your project come to life as the camera flies by! 

 Put it on the Web! With InfraWorks 360 2017, you can now publish public models, 
allowing any stakeholder an opportunity to view, navigate, fly, and understand your 
project! 
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Be a Showoff! 
The engineering is easy. We know how to 
design a site, how to make the water drain, 
how to optimize a parking lot. Sometimes, the 
PR campaign is harder than the engineering! 
Hopefully, with the set of tools and processes 
we’ve covered in this class, you’re feeling 
confident in expanding your own skills, and 
your value to your firm.  
 
 
 
 
 
 
Special Thanks to Jason Schmidt and the team at Big Red Dog for letting me show off their 
project site. Any mistakes or weirdness in the display of their design is purely on me for rushing 
through the process. Thanks for being a friend and fellow design junkie for all these years, 
Jason! 

 
 

 

 
 
 
 


